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top 5 winners predicted for 2011 
1. Virtual Cloud — Services that allow you to have 

your desktop in the cloud will become common place 
in 2011. 

2. Mobile Apps — Mobile applicaƟons are sƟll and 
will conƟnue to thrive as people find new uses for their 
cell phones. 

3. Virtual Technology — Working from home or on 
the road is growing all, virtual technology businesses 
will conƟnue to prosper and thrive. 

4. ConnecƟvity — Cell signals and Internet connec‐
Ɵvity will reach remote areas, as staying connected 
regardless of locaƟon becomes more important. 

5. Scalability — If it doesn’t scale, it will lose luster. 
Scalability is hot, and a must for all technology in to‐
day’s society. 

top 5 losers for 2011 
1. Privacy — Privacy is back on the list, recent news 
that mobile applicaƟon providers collect data about 

what is hot & what is not 
in technology for 2011 

not only the locaƟon and habits of their users has cre‐
ated more paranoia about personal informaƟon in 
cyberspace. 
2. Social Noise — Social media channels like TwiƩer 
are drowning in spam, and the quality of the channel 
has degraded with the rise of the chaƩer. 
3. Transparency — Unfortunately the woven fibers of 
the web, make it very easy for savvy individuals to 
hide or obfuscate their idenƟty. While transparency is 
preached rarely is it pracƟced. 
4. RegulaƟon — We are not geƫng any closer to any 
type of Internet standards or regulaƟons. The Internet 
sƟll remains the wild west and while pressure can be 
applied, there is sƟll no centralized body for governing 
the Internet. 
5. Land Lines — Land lines will become a thing of the 
past, as home phone numbers are replaced by phone 
numbers for individuals. 
 

last year’s predicƟons how did we do? 
Readers can assess my ability to predict based on last 
year’s collecƟon of technology predicƟons at: 
  2010 ‐ hƩp://www.small‐business‐
soŌware.net/whats‐hot‐whats‐not‐2010.htm  
  2009 ‐ hƩp://www.small‐business‐
soŌware.net/whats‐hot‐whats‐not‐2009.htm 
 
Sharon Housley manages markeƟng for FeedForAll 
hƩp://www.feedforall.com soŌware for creaƟng, ed‐
iƟng, publishing RSS feeds and podcasts. In addiƟon 
Sharon manages markeƟng for RecordForAll hƩp://
www.recordforall.com audio recording and ediƟng 
soŌware. 
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“Members Helping Members” 
(since 1983) 

Board of Directors 
2010-2011 

 
  Robin Seidenberg . . .. . . . . .. . . . President 
    president@lcace.org     
   
  Linda Busch . . . . . . . . . ... . ..Vice President 
    vicepresident@lcace.org 
 
  Bobby Jacobs. .  . . . . . . .. . . . . . . Secretary 
    secretary@lcace.org 
 
  Winnie Frost . .  . . . . . . . . . . . . . . Treasurer 
    treasurer@lcace.org  
 
  Julio Rivera  . . . . . . . . . . . . .. . . . Programs 
    programs@lcace.org 
 
  Lester Larkin . . . . . . . . . . . . . . Membership 
    membership@lcace.org 
 
  . .. .  . . . . . Public Relations 
   pr@lcace.org   
 

Volunteers 
 Webmaster ……………………. Lester Larkin 
   webmaster@lcace.org 
 
 Newsletter Editor …Dwight “J.J.” Johnson 
   editor@lcace.org 

The LCACE News Journal is published eleven 
times annually. Members are encouraged to 
submit contributions which will be acknowledged 
in this newsletter. 
 
Send articles to editor@lcace.org 
Permission is granted to reproduce any or all 
parts of this newsletter in other User Group 
publications, provided that credit is given to 
LCACE and the individual author(s).  
 
The News Journal is produced using a 
L.C.A.C.E  Logo designed on an Atari Stacy 
Laptop in 1989 by Dwight Johnson Jr. 

Lake County Area 
Computer Enthusiasts 

 
LCACE 

c/o Group Ambassador 
 

“J.J.” Johnson 
 

Membership 
Membership in LCACE is open to all individuals 
and families interested in personal computing. 
Annual dues are $20.00 per individual/family. 
Applications for membership may be obtained at 
the monthly meeting, by request on the club 
hotline, and are now available on our web site at  
- http://www.lcace.org. 

 
Meetings 

LCACE meetings are usually held on Saturdays 
at the Grayslake Area Public Library, 100 Library 
Lane, Grayslake, Illinois. The meeting room 
opens at noon and  the formal meeting begins at 
12:30 p.m.  All meetings are open to the public.  
Bring a friend! 

 
Newsletter Submissions 

Club members are welcome to submit classified 
ads, reviews, tips and other articles for 
publication, to our newsletter editor in Microsoft 
Word format (.doc). Publication deadline are 
the 20th of the month all ads, and articles. 
Please refrain from using tabs or special 
formatting.  

 
Newsletter Advertising 

Ad rates per issue: Full page - $25, Half page - 
$15, Quarter page - $10, Business Card - $5. 
Discounts are available on advance purchase of 
multiple issues. Please send camera-ready copy 
and payment to the club address by the 15st of 
the month preceding publication. For more 
information on ad pricing, please call our Hotline. 
Ads are FREE to all paid members. 
 

 Notice 
LCACE WILL NOT CONDONE  or knowingly 
participate in copyright infringement of  any kind. 
The LCACE News Journal is published by and 
for LCACE members. Opinions expressed herein 
are those of the individual authors and do not 
necessarily reflect the opinion of LCACE, the 
membership, the Board of Directors, and/or our 
advertisers. 
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Robin’s RAMblings 

Our March 12th meeting promises to be exciting.  
When Staples visited our January 9, 2010 LCACE meet-
ing, the techs spoke about Windows 7.  They mentioned 
that Windows XP Mode and Windows Virtual PC were 
available if you purchased Windows 7 Professional or 
Ultimate.  Several members found this most interesting 
and in a matter of months owned Windows 7 Profession-
al or Ultimate. 
 
We will have a "double header" when Staples' techs re-
turn March 12th:  they will discuss the latest in technolo-
gy AND will offer a free PC tune up to anyone who 
brings their computer to the meeting.  That's right.  If you 
bring your computer, their techs will tune it up for you at 
no charge during the meeting.   
 
We have exciting programs scheduled for 2011: 
 
March 12, 2011-Staples of Mundelein techs will discuss 
the latest in technology  and offer FREE PC Tune ups 
during the meeting 
 
April 2, 2011-Elections, club party, show and tell, ask the 
gurus 
 
May 14, 2011-Digital macro photography by Wendy 
Warden 
 
June 11, 2011-Online banking/internet security/identity 
theft-Detective Tim Warner, Grayslake Police Depart-
ment 
 
July 9, 2011-LCACE picnic at Liz and Fred Barnett's 
house 
 
August 13, 2011- Do you have ideas about programs you 
would like?  Please contact Julio Rivera, pro-
grams@lcace.org, or email me at president@lcace.org. 
 
LCACE has a three step election process. We take nomi-
nations for board positions in February, March, and 
April. We elect our board at the April meeting, and then 
choose our president from the people elected to serve on 

the board. Please start to think of people you would like 
to nominate. Remember that you can nominate yourself. 
 
Liz Barnett, Linda Busch, Winnie Frost, Bobby Jacobs, 
Lester Larkin, and Robin Seidenberg accepted nomina-
tions at the February meeting. 
 
Everyone enjoyed Julie Bell's excellent program on 
Linux Ubuntu at our February meeting.  Guests included 
Joe Milakovic (www.joeknowsbiz.com), Jim Swan, and 
Travis Whitlow.  Gary Hesse was our 50/50 winner.     
 
After the meeting, Richard Eisenmann quipped that he 
would back up if he could find the reverse gear on his 
computer.  Look for a presentation on backups soon. 
 
We now have a link to www.windowssecrets.com on our 
club website. You may want to subscribe.  "The Win-
dows Secrets Newsletter brings you essential tricks for 
running Windows XP, Vista, 7, Internet Explorer, Fire-
fox, Windows Update, and more — weekly, free."  I've 
found some really useful information there.  
 
Have you visited www.slickdeals.net?  You might get 
hooked.  www.pricegrabber.com remains my favorite 
shopping bot.  The site allows you to compare prices on a 
surprising array of items. 

 

  Happy computing! 

 Begin your message right at the top of the reply. 
 Include the original message you received below. 
 Make sure your signature is above the original 

message. 
 When “forwarding” emails, delete the sender’s 

personal informaƟon and any included email ad‐
dresses from previous “forwards.” 

 When “forwarding” to more than one recipient, 
place their email addresses in the BCC line of the 
email. This protects their privacy and prevents un‐
scrupulous computer users from sending spam 
and viruses to lists of email addresses that they 
have acquired from “forwarded” messages. 

format your email reply  

correctly 
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       Lester Larkin 

Lester joined LCACE in 1986 and 
as served as vice-president, mem-
bership chairpersion and webmas-
ter. Lester was born in The Sum-
mer of '42 (great movie title, eh!) 
on July 11 in the Oak Park Illinois 

hospital. One of my younger nursery room mates was a 
much younger Harrison Ford. At the time, 2 days 
seemed like a lifetime. As an older resident, I was in a 
better position to advise him on his career choices. I 
don't know if he heeded any of my advice . . . there was 
lots of background noise in the room. Besides that, you 
know how kids are. I suppose he did alright, though. 
 
I attended Arlington High School from 1957 through 
1959, then joined the U.S. Navy in 1959, and got out in 
1963. Nancy St. Laurent and I got married in 1964. We 
have 4 children , 7 grandchildren and 1 great-
grandchild as of 12/8/10. 

 
  Robin B. Seidenberg 
 
Robin joined  LCACE in 2002 
and has served as president, vice 
president and program chairper-
son. Robin is a retired educator/
business owner, has been at-
tempting to use a computer 

since her son received an Apple II+ in 1982. She has 
served as publicity chair, vice president, and president. 
Robin hopes to increase member participation by add-
ing special interest groups to our current programming.   

 
       Winnie Frost 
 
Winnie Frost became a member of 
LCACE 1998 after she and her hus-
band Jack were apprehended in a 
Computer City store at Gurnee Mills 
by J.J. Winnie hails from Highland 

Park, IL and presently resides in Fox Lake with her hus-
band Jack. She Works as an administrative assistant to 
the controller.  Get checks from mail, do the deposits 
and key them.  She runs the company's filing systems to 
maintain adequate customer and IRS records. 
For entertainment, she loves computer cards, photog-
raphy, fishing and watching the Discovery Channel. 
When not watching Discovery, she is watching any 
movie with Morgan Freeman or Gene Hackman, so I 
take it one of her favorite movies just may be 
“Shawshank Redemption”.  Her favorite food is any 
pasta dinner, although she said she can’t stop eating 
“chocolate” which I assume must be dessert.  
Winnie has been the treasure of LCACE since 2003 
which is why she states she wants people to remember 
her as “being careful with their money.”  With that be-
ing said, we now know why her favorite computer pro-
gram is Quicken and a good percentage of her computer 
time is spent using Excel and Quicken to track spending 
and tax educible items. So with all this computer time, I 
guess if you disturb her you will hear her say “Get Out-
ta Here!” 

 
 
 Liz Barnett 

 
 
 Bobby Jacobs 

 
 
 Linda Busch 

 
 
 Linda Koudelka  
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Excel makes it easy to hide and unhide columns. What 
isn’t so easy is displaying a hidden column if that col-
umn is the left-most column in the worksheet. For in-
stance, if you hide column A, Excel will dutifully fol-
low out your instructions. If you later want to unhide 
column A, the solution isn’t so obvious. 

To unhide the left-most columns of a worksheet when 
they are hidden, follow these steps: 

1. Press F5. Excel displays the Go To dialog 
box. 

 
The Go To dialog box. 

2. In the Reference field at the bottom of the 
dialog box, enter A1. 

3. Click on OK. Cell A1 is now selected, even 
though you cannot see it on the screen. 

4. Unhide the column. (In Excel 2007 or Excel 
2010, display the Home tab of the ribbon and 
click Format | Hide & Unhide | Unhide Col-
umns. In older versions of Excel choose For-
mat | Column | Unhide.) 

Another way to display the first column is to click on 
the header for column B, and then drag the mouse to 
the left. If you release the mouse button when the point-
er is over the gray block that marks the intersection of 
the row and column headers (the blank gray block just 
above the row headers), then column B and everything 
to its left, including the hidden column A, are selected. 
You can then unhide the column. 

A third method is even niftier, provided you have a 
good eye and a steady mouse pointer. If you move your 
mouse pointer into the column header area, and then 
slowly move it to the left, you notice that it turns into a 
double-headed arrow with a blank spot in the middle as 
you position the pointer over the small area immediate-
ly to the left of the column B header. This double-
headed arrow is a bit difficult to describe; it looks most 
closely like the double-headed arrow that appears when 
you position the pointer over the dividing line between 
column headers. It is different, however, because in-
stead of a black line dividing the double arrows, there 
are two black lines with a gap between them. 

Protecting Your Identity 

Tip of the Month 
 

THE KEY IS IN THE LOCK: When making online 
purchases, one of the keys to making certain your 
transaction is secure will be the icon of the lock, 
somewhere in the window of the browser. You 
should even be able to click on it to see details of 
a site’s security. 

WORDTIPS Displaying a Hidden First Column 
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There may be many times that you need to print either 
odd or even pages in a print job. For instance, you 
may want to put your pages through the printer twice 
so you can print on both sides. This is easy to do in 
Word by following these steps: 

1. Press CTRL+P. Word displays the Print dia-
log box. 

 
The Print dialog box. 

2. Adjust the printing settings as desired. 

3. Using the Print drop-down list at the bottom 
of the dialog box, choose either Odd Pages 

or Even Pages, as desired. (Make sure you 
use the Print drop-down list, not the Print 
What drop-down list.) 

4. Click on OK. Your document is printed. 

The above steps work great in any version of Word up 
through Word 2007. If you are using Word 2010, then 
the Print dialog box was done away with. You should 
follow these steps, instead: 

1. Press CTRL+P. Word displays the File tab 
of the ribbon, with printing options visible in 
the tab. 

2. Adjust the printing settings as desired. 

3. Using the first drop-down list under the Set-
tings heading, choose Only Print Odd Pages 
or Only Print Even Pages, as desired. 

4. Click on Print. Your document is printed. 

Copyright © 2011 by Sharon Parq Associates, Inc. Reprint-
ed by permission. Thousands of free Microsoft Word tips 
can be found online at http://word.tips.net. 
 

 
SCAN IT 
 
Bring old slide, file 
negative and photos 
into the digital age us-
ing the Flashpoint 3-in-
one Photo Scanner. 
Features include a built
-in 2.4 inch color LCE screen for viewing and editing 
images, and a memory card reader for SD cards. The 5-
megapixel standalone scanner is very easy to use. You 
simply place your slides or negatives into the two trays 
and press a button, which scans the image instantly onto 
your memory card. Setup in minimal as the unit is de-
signed for use immediately after plugging it into an AC 
outlet. Estimate Street Price $139. 

PRODUCT REVEIW 

COMPUTERHUMOR 

WORDTIPS Printing Odd or Even Pages 
More 
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COMPUTER QUOTEs 
 
The Internet is the first thing that humanity has 
built that humanity doesn't understand, the largest 
experiment in anarchy that we have ever had.  
- Eric Schmidt  
 
It is very clear that voice communications is mov-
ing on to the Internet. In the end, the price that 
anyone can provide for voice transmission on the 
Net will trend toward zero. - Meg Whitman  
 
The Internet lives where anyone can access it. - 
Vinton Cerf  
 
It appears that the media filters we carry in our 
heads are like computers: they've been forced to 
get faster in order to keep up with the demands 
our high-speed society puts on them. - Roy H. 
Williams  

News 

Free Microsoft Office training manuals 

Learning how to use productivity software is cru-
cial to your success with a computer. But master-
ing software like Word and Excel can take years of 
practice. 
 
The Mouse Training Company offers a long list of 
programs to train in. It has all of its training manu-
als available to download as PDFs  

I found out it is very important to keep Windows up 
to date. 
  
I had some real serious virus problems on my main 
computer which I have completely cured.  I had 
found help with someone at Microsoft.  I think the 
virus turned off my automatic update setting which 
made things worse. 
  
Below are simple instructions to check for Updates 
for windows.  It might take a few minutes for the 
connection to search your computer for updates and 
you may already have your computer set for auto-
matic updates (recommended) but even if you do, 
this is the way to make sure you have anything that 
needs to be updated. 
  
It will also allow you to download and install any up-
dates needed.  (This is all free from Microsoft) 
  
The computer I did this on is running Windows 
XP.  I also have one with Vista and another with 
Windows 7.  If you are running Vista or Windows 7 
there may be different instructions.   
  
Here are the instructions.  If you get an error coming 
back at you, there are instructions on how to copy 
the page (make a screen shot) so you can send it to 
Microsoft for further help: 
  
Keep the computer up-to-date 
======================= 
1. Please open Internet Explorer from the 
Start menu. 
2. Click Tools, and click Windows Update. 
3. Click Express to run a scan, and then fol-
low the instructions to install the available 
updates. 
  
Please be sure that if the site doesn't list any 
updates to install, it means the current sys-
tem is secure with all necessary updates in-
stalled and no troubleshooting is needed. 
Thanks for your understanding. 
  
However, if any error is encountered, please 
feel free to let me know and help capture a 
screenshot for further research.  
  
How to capture a Screenshot: 
======================= 
1. When the error appears, please press the 
Print Screen key (PrtScn) on your keyboard. 

2. Click Start, click Run, type MSPAINT, and 
click OK. 
3. In Paint, click Paste under the Edit Menu, 
click Save under the File menu, type a file 
name for the screenshot, choose JPEG as 
"Save as type", click "Desktop" on the left 
pane, and click Save. 
4. Please find the screenshot on the Desktop 
and send it as an attachment to:  
v-30joey@mssupport.microsoft.com. 

Simple to do! 
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March Door Prize Question 
 

What did critics dub the glitchy  USB "plug and play" feature of  Windows 
98? 

 

digitalcorner 
Tips of  the Month 
 

Camera round-up: High-end point-and-shoots 
Macworld (blog) 
The high-end point-and-shoots on this list are a bit big-
ger and pricier than a typical pocket camera, but 
they're also a lot more powerful. 
 
Don’t leave your camera 
You never know what opportunities will present them-
selves to you if your camera is always at your side. It 
may be a bit of extra hassle, but you will develop a 
greater sense of observation by being aware of your 
camera constantly. 
  
Shoot a Photo a Day 
No greater photographic progress can be seen than by a 
personal photo a day challenge. Watch your develop-
ment over a period of 1-3 months and be amazed at 
how far you’ve come.  
 
 

Jack Haley 

Winnie Frost 

 

Windys Comuter Repairs 
 
 
Windys  Computer Repairs in  Lindenhurst  847-356-
5527  Hours 8am to 5pm Monday - Saturday & Sunday 
Please call PHIL, offers computer related services for home 
and small businesses in the lake county area.  
Solving computer problems can be quite a task.  You may 
need a tech to help you out.  Choosing the wrong one could 
be costly and leave you worse off than before.  I have over 
several years experience working with all types of PC com-
puters.  The perfect technician will be knowledgeable, honest, 
affordable and reliable.  Just having your problems fixed isn't 
enough.  A comprehensive explanation of the problem and 
solutions to it are what is needed to meet your needs. Services 
I offer  are ON SITE service , Computer Repairs, Crashed, 
Reformat, Upgrades, Virus Removal, Custom Built Comput-
ers and others too. 
Tag Line: COMPUTER WON'T BOOT...WHO u GOIN 
TO CALL.... 
 
Thanks, Phil 
  
COMPUTER WON'T BOOT...WHO u GOIN TO 
CALL.... 
*Windys Computer Repairs* 
www.windyssatellite.com  
Phil Nocerino 
847-356-5527 

   John S. MC ENERY 

 
MC ENERY - John S. on Feb. 15, 
2011. Lifelong resident of Merrick 
and Parishioner of Cure of Ars RC 
Church. Beloved husband of the 

late Mary. Devoted father of Michael J. (Corrine) , Paul 
D. (Jeanne), Theresa, Kathryn V. Clark (Russell), 
Mareta E. Gallagher (Vincent) and the late Martha Var-
ney. Dear brother of Leonard Mc Enery and Mareta 
Pitler. Grandfather of Ginny, Christopher, Wayne, Jen-
nifer, Katherine, Stephanie, Brian, Scott, Peter, Mar-
yann, Katrina, James and the late Mhairi. Also survived 
by his 7 Great Grandchildren.  
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Take a good 
look, you just 

might see  
yourself. 

http://lcace.org/PhotoAlbums.htm 

Have your Web Site Advertised here, 
e-mail me at editor@lcace.org 

 
www.pegasusphotos.zenfolio.com 

 
www.RobinSeidenberg.com  

 Members 

L.C.A.C.E.  
Phone: 847.623.3815 
Web Site: http://www.lcace.org 

 
 

Alleman, Elizabeth esa2204@aol.com 

Anderson, Jean jande77893@aol.com 

Barnett, Fred BNSCom@aol.com 

Becht, George pechmem-gen@yahoo.com 

Bell, Julie jmwebstuff@yahoo.com 

Berg-Wells, Lois luludefl@yahoo.com 

Berndtson, Barton bartb64@yahoo.com 

Berry, Bob & Tracy mgd2race@yahoo.com 

Bitterman, Jay bittjayl@aol.com 

Busch, Linda lindashrub@att.net 

D’Agostino, Robert rusirius2736@sbcglobal.net 

Ditman, Bill william.ditman@comcast.net 

Eisenmann, Richard eisenrich@sbcglobal.net 

Florian, Sherry florina3@earthlink.net 

Frost, Jack Jfrost13@sbcglobal.net 

Frost, Winnie wfrost13@sbcglobal.net 

Garling, Richard richgarling@yellobirdmktg.com 

Gothann, Edward eddiegothann@yahoo.com 

Halley, Jack jack96@aol.com 

Hamilton, Bill hamiltonbill24@comcast.net 

Hanlon, Terri terhanlon@comcast.net 

Henriksen, Henry hhenriksen@wi.rr.com 

Hesse, Gary pocanada@sbcglobal.net 

Hobson, Marshia omsgadget@yahoo.com 

Jacobs, Bobby bobj2361@gmail.com 

Johnson, Dwight jj1450xl@yahoo.com 

Kalinoski, Donna donnaleek@juno.com 

Kline, Cherie catmom1001@aol.com 

Kostelnik, Steve steve_kostelnik@usa.net 

Koudelka, Linda & Robert koudelka3@comcast.net 

Kusiak, Joseph juj014@att.net 

Lagoni, Doreen bearmagic1999@aol.com 

Larkin, Lester LesLarkin@aim.com 

Lewis, Carolyn lewis.linwood@att.net 

Martin, Donald dmartin339@comcast.net 

Mata-Guzman, Marta marta5131959@yahoo.com 

McEnery, John bigjohn1@optonline.net 

McEnery, Mike mmcenery@sbcglobal.net 

Nickels, Cheryl cnickels1110@yahoo.com 

Nocerino, Phil windpiper2@yahoo.com 

Ortseifen, Patricia patricia@ortseifen.com 

Rehberger, Eric graduates63@gmail.com 

Rivera, Julio jlrivera@db3mail.com 

Salsburg, Leslie leslie164@juno.com 

Savage, Danjean & Ken kennethisavage@hotmail.com 

Seidenberg, Lew drlew1@aol.com 

Seidenberg, Robin anguslechat@aol.com 

Smatlak, Ellen emsmis@hotmail.com 

Straw, Gerald gkstraw@comcast.net 

Sturek, Jorja jksturek@sbcglobal.net 

Sutherland, Dorothy deedee1938@yahoo.com 

Urh, John johnurh@sbcglobal.net 

Wagner, Richard & Belinda SenoritaBW@AOL.com 

Wells, Alden alden_racing74@yahoo.com 

Rudnit, Harriet hrudnit@yahoo.com 
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March	

12	

Saturday 

Next  
Meeting 

Meeting Agenda: www.lcace.org 
 

Meeting 
Agenda 

 

FREE 
PC Tuneup 

New Technology by  
Technology 
Techies 

 
• Users burned again by Farcebook’s lack of interest in 
privacy, lack of self‐regulaƟon and lack of regulaƟon of 
app developers. The correct answer is “Deny” always 
“Deny.”  
• Why can’t Facebook do anything about it? They have 
some great IT people working for them.  
• BTW, Facebook currently has another page on its site 
that will lead to this survey also. hƩp://
www.facebook.com/pages/tell‐you‐how‐many‐profile‐
views‐you‐have‐/435131895583#!/ pages/tell‐you‐how
‐many‐profile‐views‐you‐have‐/435131895583?v=wall  
• FB is whatever you make of it. I know plenty of peo‐
ple that have reconnected with long lost buddies or 
deployed people that keep in contact with their fami‐
ly’s and friends.  
• It seems people just won’t learn to stop clicking on 
and joining any and every liƩle thing on Facebook…I 
make it a point to immediately block any app someone 
sends to me…Facebook is only for chit‐chaƫng and 
posƟng pics. That’s it!  
• Nobody has to fill out all their informaƟon, but…I feel 
no pain for them when they find out their personal info 
was sold.  

comments from facebook users  

  benefits of 
USER GROUP MEMBERSHIP 

 
 

• Product & “How To”demos 
• Free raffles and magazines 
• Help from other members 
• NewsleƩer and web site 
• Special offers & discounts 
• Monthly meeƟngs 
• AffiliaƟon with worldwide group 

 

User groups represent the spirit of the fronƟer, a commu‐

nity geƫng together to do things that no individual ought to 
have to do alone. The pioneers of the American west got 
together for barn raisings, caƩle roundups, and the occa‐
sional party. The pioneers of new technology get together 
for install fests, new user training and support, and just plain 
fun. Being part of a user group is the best way to get more 
out of your computer, and lets you make friends while 
you’re at it. 


